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Welcome to UltraUV 
 
UltraUV is a PC application software developed by RIGOL for the Ultra-6000 
series and Ultra-3000 series UV-VIS spectrophotometer. This software is design on 
the basis of the commonly used standard drive VISA and you can build the 
communication between the software and the instrument via the USB, RS232 or 
LAN interface to control the instrument. UltraUV provides easy operation and 
powerful functions (including data acquisition, analysis and report).  
 
UltraUV mainly consists of five parts: 
 

 Spectrum Module 
 Kinetics Module 
 Photometric Module 
 Quantitation Module 
 Report Generator 

 
Other Features: 
 

 Easy operation mode and clear interface layout 
 Real-time display of the current wavelength and absorbance and timely 

control of the instrument 
 Diagrams for displaying, acquiring and controlling the data 
 Abundant post-processing programs, such as point pick detect, peak pick 

detect and area detect 
 Various operation functions 
 Normalization, user management and operation log 
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Document Overview 
 
This manual introduces how to make measurements using the UltraUV spectrum 
work station with the Ultra-6000 series and Ultra-3000 series UV-VIS 
spectrophotometer. You are recommended to read the Ultra-6000 Series UV-VIS 
Spectrophotometer User's Guide/Ultra-3000 Series UV-VIS 
Spectrophotometer User's Guide and this manual to get a complete 
understanding as far as possible of the functions as well as the operation methods of 
the instrument and the software before using the software. 

 Main Topics: 

 Software Installation and Configuration  

 System Management  

 Shortcut and System Settings  

 Measurement  

 Report and Log  

 Troubleshooting  

Document Conventions: 
Blue represent a specified platform and the introductions following are 

only applicable to this platform. 
 

Black represent those items (such as the menu items and the dialog box 
items) in the software that must be selected or clicked; represent 
the parameter names, input control modules and display control 
modules at the front panel, dialog box as well the names of some 
dialog boxes and menus. 
 

Aquamarine represent parameters that can be set or selected. 
 

Orange represent a link. 
 

 
inform users to adopt precautions to avoid data loss or system 
crash; inform users to pay attention to the notices during the use 
of the software. 
 

 
inform users to pay attention to important information. 
 

Tab represent the buttons on the keyboard. 
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Chapter 1 Software Installation and 
Configuration 
 
This part mainly introduces the running environment of UltraUV as well as how to 
install the software and set the external parameters of the software using the 
configuration program. 
 

 Main Topics: 

 Configuration Requirements  

 To Install the Software  

 To Update the Software  

 To Uninstall the Software  

 To Configure the Instrument  

 Basic Software Interface  
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1.1 Configuration Requirements 
 
UltraUV can be used under Microsoft Windows XP/ Windows Vista/ Windows 7 
Chinese and English operation system. Make sure your PC fulfills the following 
requirements before installing the software.  
 

 A free COM, USB or LAN interface (for connecting the Ultra-6000 series 
instrument). 

 A CD ROM or DVD-ROM drive (for installing UltraUV). 
 

Recommended configurations: Pentium1.4GHz CPU, 256MB memory, 32MB 
graphics acceleration graphics card, 17 inches color display, CD-ROM or DVD-ROM. 
Wherein, the graphics acceleration graphics card is mainly used to make 3D 
acceleration for the 3D chromatograms. Therefore, you can just install a normal 
graphics card if your requirement of 3D chromatogram is not high.  
  

Besides, at least 20MB hard disk space is required for UltraUV. Therefore, make 
sure that there is enough space for the software on your hard disk.  
 
 

1.2 To Install the Software 
 

Installation of UltraUV requires more than 800MHz CPU, more than 64MB memory 
and 50MB to 200MB hard disk space depending on the number of components to be 
installed. 
 

Installation Procedures: 
 Insert the CD into the drive. 
 At this point, the system runs the installation guide program automatically (if 

not, select the Setup.exe file in the CD and run it manually). 
 Follow the software wizard to install the software. 

 A start-up icon  will be created in the PC start-up item, program 
directory and on the desktop after the installation succeeds. 
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Note: 
 Make sure that you have the system administrator permission as well as the 

write and read permissions of the work station files before installing the 
software. 

 You need to install the VISA resource library when installing the software; 
otherwise, the communication between UltraUV and the instrument can not 
be built. As the VISA resource library would not be installed automatically 
when installing the software, you need to install the NI-VISA manually and 
NI-VISA 4.6.2 version or higher is recommended. If your PC is already 
installed with the VISA resource library, ignore this information. 

 

 

Tip: 
 Security warnings might be displayed during the installation. To install the 

software successfully, unblock the installation or add the software to the 
trust list of the Windows firewall. 

 This software provides two application modes (Normal and GLP). When GLP 
is selected, user name and password are required for logging in to the 
system to limit the visit of the system. 

 
 

1.3 To Update the Software 
 

RIGOL will update the software on regular or irregular basis. To ensure the 
optimum performance of the software, please update your software timely. 
 

Tip: 

 Uninstall the software installed before installing the new version to ensure 
correct installation as update of the software via direct overwrite might 
introduce in unnecessary error. 
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1.4 To Uninstall the Software 
 

If you need to remove UltraUV from your PC, run the "Uninstall" program in the 
program folder and the system will uninstall UltraUV from your PC automatically. 
 

Tip: 

 You can also remove the software by WindowsStartControl Panel, 
select UltraUV in the program list and click Change/Delete. 

 All the sample data will be deleted when you delete UltraUV. Therefore, 
make a copy of the desired file data. Those files created and stored in the 
hard disk will not be deleted. 

 By default, the measurement data file is stored in the Data folder under the 
directory of the installation file. Besides, you can find the corresponding 
folder via the shortcut of UltraUV on the desktop. 
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1.5 To Configure the Instrument 
 
After the software is installed, double-click the run program and the configuration 
dialog box (as shown in the figure below) will be displayed automatically after the 
system starts up. This dialog will be displayed each time you run UltraUV and click 
Cancel if configuration is not necessary. 

 

 

Tip: 

 In GLP mode, the user login dialog box is displayed when you double-click the 
run program. If a new account is created, select the desired user name, input 
the correct password and click OK to log in. 
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Communication 
 
Set the communication port to be used. UltraUV can communicate with the 
instrument via RS232, USB and LAN. After the software is connected with the 
instrument, the ports available (such as COM1) will be displayed in the 
communication list. If the VISA library is not installed, the communication list would 
be blank and the communication between the software and the instrument can not 
be built.  
 
Test 
 
Test whether the communication between the instrument and the software is normal. 
The instrument must be connected to the PC before testing the communication. The 
operation method is as follows. 

 Connect the PC and Ultra-6000 using the serial cable (RS232). 
 Power on the instrument and turn on the instrument power switch. 
 At this point, the ports available (such as COM1) are displayed in the 

communication list. 
 Click Test and the system will test the communication between the software 

and the instrument automatically. After the test is finished, the 
communication dialog box is displayed to inform you the communication 
state. If the communication succeeds, click OK or close the dialog box; if 
"Communication Test Error" is displayed, refer to Troubleshooting to 
solve the problem. 

 
Device 
 
Set the instrument-related parameters. 
 
Device Type 
View the model of the instrument. By default, it is 6600A and can not be set. 

  
Lamp Change Wave (nm) 
Set the interchange wavelength of the deuterium lamp and tungsten lamp and the 
range is from 320nm to 380nm. 
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Accessory 
The accessories available include single cell, integrating sphere and 8-series 
multicell. 
 
Click OK to save the setting and exit the configuration dialog box after setting the 
corresponding parameters and the communication test becomes normal. Click 
Cancel or directly close the configuration dialog box to give up the current setting. 
 
 

1.6 Basic Software Interface 
 

Click the UltraUV start-up icon  to start up the work station. Note: the 

Configuration window will be displayed each time you start the work station, 
please refer to the corresponding introduction to configure the parameters and then 
click OK to enter the main interface of the work station as shown in the figure below. 
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Shortcut Toolbar 
  
Provide shortcuts for the commonly used operations (include software interface style, 
connecting/disconnecting the instrument, setting the specified wavelength (the 
range is from 190nm to 900nm) and self-check) of the work station.  
 
Menu Bar 
  
Display the operation menus (include File, Acquisition, Chroma, View and 
Manage) of the work station. Each menu contains multiple sub-menus. The working 
area displays different content when different menu is selected. Note: there are not 
the Chroma and View menus in photometric and quantitation measurements.  
 
Function Switch 
  
Used to switch among the Method, Acquisition and Chroma/Data functions of 
the work station. 
  
Working Area 
  
Used to set the measurement mode, acquisition and chromatogram information. 
  
Measurement, Report and Log 
  
Used to select the type of measurement of the work station, generate measurement 
report and view measurement log.  
  
Status Bar 
  
Display the current wavelength and absorbance. 
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Chapter 2 System Management 
 

Two application modes (Normal and GLP) are provided when installing UltraUV. 
When GLP is selected (the default user name and the password are "Admin" and 
"123" respectively when you log in to the system for the first time), you can set the 
system through the options under the Manage menu in the menu bar. 
  
This section introduces the basic system management. When UltraUV is installed 
for the first time, the system contains four specified groups (Admin, Developer, 
Operator and Guest). Wherein, the administrator group has all the permissions and 
when a user is added to this group, he can access the UltraUV system without any 
limit. Generally, in order to control the visit of the system, groups with different 
access levels are created and users are distributed to the corresponding groups.  
 

Main Topics: 

 To Change the Password 

 User and Group 

 GLP Items 
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2.1 To Change the Password 
 

Click ChangePassWord under the Manage menu to change the login password of 
the user. 

 

 
1.  Input the current password.  
 
2. Input the new password.  
 
3. Input the new password again.  
 
4. Click OK.  
 

Tip: 

 The user currently logged in can change the password only when he has the 
permission to change password. 
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2.2 User and Group 
 

For easier management, every user should belong to a group. The system using 
permissions of each user can be controlled by setting the permissions. The following 
rules apply to the user and group. 
 

 Group is the combination of users 

 Every user must belong to a group 

 Group has specified permissions  

 Users in the same group enjoy the same permissions 

 

Main Topics: 

 To Create a New Group 

 To Delete a Group 

 To Modify Group Permissions 

 To Create a New User 

 User Attribute 
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2.2.1 To Create a New Group 
 

Click User Management under the Manage menu and select the Group option in 
the pop-up dialog box. 
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Users can add a new group through two methods: create a new group; use the 
permissions of the group already exists. 
  
 Create a new group: 
  
 1. click New in the dialog box to open the NewGroup dialog box. 
  
 2. Input the name of the group and you can also add a description of the group. 
  
 3. Select the permissions of this group in the permission checkboxes. 
  
 4. Click OK. 
  
 Use the permissions of the group already exits: 
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 1. select a group from the group list. 
  
 2. Click Copy to create a copy of that group in the group list.  
  
3. Select the group newly created, click Rename and you can modify the name of 

this group in the pop-up dialog box.  
 
 

2.2.2 To Delete a Group 
 
1. Select the group to be deleted in the group list. 
 
2. Click Delete. 
 

Tip: 

 Group that contains users can not be deleted. Otherwise, the users in the 
group will also be deleted. 

 The group currently logged in to the system can not be deleted. 
 The system group can not be deleted. 
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2.2.3 To Modify the Group Permissions 
 

You can modify the group permissions through the Attribute option. 

 
 
1. Select the desired group from the group list. 
 
2. Click Attribute under the Group option and the Group attribute dialog box will 
be displayed. 
 
3. Modify the permissions of this group via the permission checkboxes. 
 
4. Click OK. 
 

Tip: 

 The permissions of the group of the current user can not be modified. 
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2.2.4 To Create a New User 
 

You can create a new user via the User option in the User Management dialog 
box. 

 
 
You can add a new user through two methods: create a new user; use the user 
already exists. 
 
Create a new user: 
1. Click New under the User option to display the NewUser dialog box.  
 
2. Input the user name and you can also input the full name and password of 
this user. 
 
3. Select a group for the new user in the Group dropdown list.  
  
4. The CreationD... field uses the default system date and time.  
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5. You can also add a description of the user. 
 
6. Click OK. 
  
Use the user already exists: 
 
1. Select a user from the user list. 
 
2. Click Copy to create a copy of this user in the user list. 
 
3. Select the user newly created, click Rename and you can modify the name of the 
user in the pop-up dialog box.  
 

 Tip: 

 The current user can not be deleted or renamed. 
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2.2.5 User Attribute 
 
Select the desired user, click Attribute under the User option and the 
UserAttribute dialog box is displayed as shown in the figure below.  

 

Click ChangePassword in the figure above and you can modify the password of 
this user in the pop-up ChangePassword dialog box as shown in the figure below. 
For more details, please refer to To Change the Password. 
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2.3 GLP Items 
 

Click GLP Items under the Manage menu and you can make the following settings 
in the pop-up GLP Items dialog box. The items selected will be applied to the 
system. 

 

 
Allow locking system 
When it is selected, the system is locked and other users can not operate the system. 
Only the “administrator” can unlock the system. 
 
Data automatically save 
When it is selected, the processed data will be automatically stored in the default 
storage directory of the system. 
 
Data automatically save when print or exit 
When it is selected, the data will be automatically stored in the default storage 
directory of the system when you exit from the software or print data. 
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Data files overwrite is forbidden 
When it is selected, the data files will not be overwritten; otherwise, prompt message 
will be displayed. 
 
Row or column delete in the result table is forbidden 
When it is selected, the rows and columns in the result table can not be deleted. 
 
Row or column editing in the result table is forbidden 
When it is selected, the rows and columns in the result table can not be edited. 
 

 Tip: 

 You can not switch between GLP mode and Normal mode. To change the 
application mode, you need to re-install UltraUV and select the desired 
application mode. 
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Chapter 3 Shortcut and System 
Settings 
 
This part mainly introduces the relative operations of the shortcut toolbar and system 
settings in the main interface of the software to help you to quickly understand their 
using methods. 
 

 Main topics: 

 Shortcut Toolbar  

 System Setting  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



RIGOL Chapter 3 Shortcut and System Settings 

UltraUV User’s Guide 3-2 

3.1 Shortcut Toolbar 
 

 

 

Sub-menus of the shortcut tool bar: 

Menu 
Icon 

Name Function 

 Style Set the style of the software interface 

 Connect 

Build communication between UltraUV and 
the device 

 Disconnect 

Disconnect the communication between 
UltraUV and the device 

 Goto WL 

Set the system to operate under the specified 
wavelength 

 

Self Check Perform self-check 

 
Style 
 
To fulfill the various needs of users, UltraUV provides eight interface styles including 
classic blue, classic silver, classic black, modern blue, modern silver, modern black, 
Vista and Win7. 
 
Operation method: 

Click the small arrow at the right of to select the desired interface style. 

Tip: 

 You can switch the interface style at any time during your operation without 
affecting the operation. 

 The system-related setting icon would change with the interface style. 
 This manual adopts the default interface style (Win7). 
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Connect 
 
Operation method: 

 Connect the PC and the Ultra-6000 series instrument using the 
corresponding data cable of the communication interface.   

 Power on the instrument and turn on the power switch of the instrument.   

 Click , the software will search for device automatically and build 

communication between the software and the device automatically. If the 

device is not correctly installed, the dialog box will be displayed to tell you 

that the connection fails. In this situation, please refer to Troubleshooting.  

 

Tip:  

 If no device is connected, you can still run UltraUV, but you can only view or 
process data and can not make measurements. 

 
Disconnect 
 
If UltraUV will not be used to control the instrument for the moment, you can 
disconnect it from the device. Note that when the software is disconnected from the 
device, you can not make measurements via the software, but can still view or 
process data. 
 
Operation method: 

Click in the shortcut toolbar to disconnect the software and the device.  

 

Tip: 

 You can also disconnect the software and the device by clicking , 

selecting Config Device in the dropdown list and click Yes in the pop-up 
warning dialog box.  
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Goto WL 
 

Click , the Goto WL dialog box is displayed as shown in the figure below, you 

can set the wavelength and then click OK. At this point, the motor rotates to update 
the parameter, the wavelength and absorbance will be displayed in the status bar at 
the bottom of the interface accordingly and no operation is allowed.  
  

 

 

Tip: 

 The wavelength should be an integer between 190nm and 900nm. If the 
wavelength input exceeds this range or characters other than number are 
included, the warning dialog box will be displayed.  

 This function is not available when the device is not connected. 
 
Self Check 

Ultra-6000 series provides self-check function. Click  in the shortcut toolbar 

and the dialog box as shown in the figure (left) below will be displayed. Select the 
spectrum bandwidth (the default is 2nm) before executing self-check. Then, click 
Start and the instrument perform self-check item by item as shown in the figure 
(right) below.  
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If the self-check passes, the dialog box as shown in the figure below will be displayed 
telling you that the self-check passes. 
 

 

 
If the self-check times out, the dialog box as shown in the figure below will be 
displayed. 
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If the self-check fails, the dialog box displaying the failed items as shown in the 
figure below will be displayed. Please find and solve the problem immediately until 
the self-check passes.  
 

 

 
 
Ultra-6600A: 
Search for the initial position of each step motor; scan the zero degrees and 656.1nm 
of the two pre-grating; scan the zero degree, 656.1nm and 486nmof the main 
grating and set the wavelength to 500nm automatically. 
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Ultra-6600 and Ultra-6100: 
Search for the initial position of each step motor; scan the zero degree, 656.1nm and 
486nm of the main grating and set the wavelength to 500nm automatically. 
 

Note: 

 Do not exit the software or disconnect the software and the device during the 
self-check; otherwise, you can not get the self-check result and error warning 
will be displayed at the next start-up.  

 Self-check must be performed at each start-up; otherwise, the absorbance, 
transmittance and reflectance measured would be inaccurate and the grating 
and the motor might crash during the measurement. 
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3.2 System Setting 
 

Click and make the system related settings in the pop-up dropdown menu. 

 
 
Sub-menus of system setting: 

Menu 
Icon 

Name Function 

 

Config 
Device 

Select the communication port, test the 
communication, set the interchange wavelength and 
select accessories.  

 

Device 
Information 

View the device information including the model, 
serial number, production date, DSP version, tungsten 
lamp information and deuterium lamp information.  

 

Software 
Setting 

Set the number of digits after the decimal point and 
the data storage location.  

 
About Display UltraUV information. 

 
Exit Exit UltraUV. 

 
Config Device 

Click  and the warning dialog box will be displayed warning you that instrument 
configuration would affect the software setting, all the methods and data will be 
abandoned and you are recommended to save them manually before configuring the 
instrument. Click Yes, the software enters the instrument configuration interface 
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and the connection between the software and instrument will be cut off; click No to 
give up the operation. 
 
Device Information 
After the communication between UltraUV and the device is successfully built, click 

, and the system will acquire the information of the current device 
automatically as shown in the figure below. 
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Tip: 

 Make sure that the device is correctly connected before viewing the device 
information; otherwise, this menu is not available. 

 
Software Setting 
Before using UltraUV for measurement, set the software-related parameters. Click 

, and the dialog box as shown in the figure below will be displayed. 

 
 
The decimal digits in chart show 
 
X 
Used to set the number of digits after the decimal points of the X axis. The range is 
from 1 to 5 and the default is 2. 
 
Y 
Used to set the number of digits after the decimal points of the Y axis. The range is 
from 1 to 5 and the default is 3. 
 
QNT 
Used to set the number of digits after the decimal point in quantitation measurement. 
The range is from 1 to 5 and the default is 3. 
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PTM 
Used to set the number of digits after the decimal point in photometric measurement. 
The range is from 1 to 5 and the default is 3. 
 
The default path data storage 
 
You can select your desired storage directory or use the default storage directory 
(the Data folder under the directory of the installation file). 
 
 
About 
 
Click About and you can view the current version and related information of 
UltraUV in the pop-up dialog box as shown in the figure below. 

 

 
 
Exit 
  
To exit the software, you can click the close button at the upper right corner of the 
software or click Exit. 
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Tip: 

 As no dialog box will be displayed and the current setting and data will not be 
stored automatically when closing the software, please store or back up the 
data before exiting the software. 

 

Note: 

 Do not exit the software or cut off the connection between the software and 
instrument during the measurement. Otherwise, the measurement data will 
be lost and abnormal prompt message will be displayed at the next start-up 
of the software. 
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Chapter 4 Measurement 
 
The core functions of the UV-VIS spectrophotometer are to make qualitative, 
quantitative or structural analysis of the material on the basis of the material’s 
selective absorption of the monochromatic light. These functions can only be realized 
via the software. This part introduces how to make a series of measurements using 
UltraUV. 
 

Main topics: 

 Spectrum Measurement  

 Kinetic Measurement  

 Photometric Measurement  

 Quantitation Measurement  

 

Tip: 

 Make sure that the instrument is connected and the communication between 
the instrument and software is normal before making measurements. 
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4.1 Spectrum Measurement 
 
In spectrum measurement, the system scans and measures the absorbance and 
transmittance of the sample at each wavelength within the specified wavelength 
segment according to the specified wavelength interval and scan speed. The 
measurement result is the variation curve of the absorbance (transmittance or 
energy) under different wavelength within the wavelength segment.  
  
The spectrum measurement is mainly used in qualitative analysis of the sample. Its 
direct diagram display mode makes the character of the sample clear and provides 
you the absorption degree of the light of the material at certain wavelength point or 
within certain wavelength range, making it an important function of the UV-VIS 
spectrophotometer.  
 
 

Main topics: 

 Spectrum Measurement Procedures  

 To Create Spectrum Measurement Method  

 To Send the Spectrum Measurement Method  

 To Edit the Acquisition Table of Spectrum Measurement  

 To Execute the Baseline Correction of Spectrum Measurement  

 To Run Spectrum Measurement  

 To Stop Spectrum Measurement  

 Chromatogram Processing of Spectrum Measurement  
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4.1.1 Spectrum Measurement Procedures 
 
The procedures of the spectrum measurement using UltraUV are as follows. 
 

 
 
 

4.1.2 To Create Spectrum Measurement Method  
 
Set the method parameters before making spectrum measurement. Click 

 to activate the spectrum measurement window and by default, the 
software switches to the method setting interface of spectrum measurement 
through which you can create a new method or open a method that already exists.  
 
 
Create Method 
 
To create a new method, click New under the File menu. The message dialog box 
will be displayed querying whether to save the current spectrum method as shown in 
the figure on the next page; click Yes to save the method in the specified directory 
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and restore the method parameters to their default values; click No to abandon the 
current spectrum method and restore the method parameters to their default values 
automatically.  

  

 

 Tip: 

 You can also set or modify the method parameters directly without clicking 
New. 

 If no method parameter is set, the default method parameters will be used 
during the measurement. 

 
 
Set the Method Parameters 
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Measurement Mode 
 
The spectrum measurement supports four measurement modes (Abs (absorbance), 
T% (transmittance), E_S (sample energy) and E_R (reference energy)). When 
integrating sphere is used, the R% (reflectance) mode is also available. Wherein, 
E_S and E_R modes can be selected at the same time. 
 
Abs 
Measure the sample’s absorption degree of the light (the absorption of different 
sample of the light is different). 
 
T% 
Measure the absorption of the material of the light. The calculation formula is as 
follows. 
Abs=-log T=-log (Es/Er)      
Wherein, Es represents the sample energy and Er represents the reference energy.  
 

 Note: 

 The calculated absorbance should be the same with that displayed at the 
bottom of the interface. 

 When the sample cell is hollow, the transmittance measured should be 
between 100.3% and 99.7% (specification: ±0.3％T). 

 
E_S or E_R 
Energy mode (sample energy or reference energy). After selecting this method, the 
PMT Voltage and Light Source Selection dialog box will be displayed at the right 
side and you need to set the PMT voltage and select the light source.  
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PMT Voltage and Light Source Selection: 
 
Auto 
When it is selected, the instrument will select voltage for the PMT automatically. 
 
Manual 
When it is selected, you need to set the PMT voltage manually. The range is from 0V 
to 1000V and the default is 380V. 
 
Light 
Select the PMT light source. It can be set to D2 (deuterium lamp), W (tungsten lamp), 
OFF (do not use light source ) and Auto. 
 

 Tip: 

 The PMT working voltage is related to the PMT gain. The service life of the 
PMT will be affected when it works under high working voltage for long 
periods of time and high working voltage can only be used when the energy 
measured is less than a certain degree. 

 You are recommended to use auto light source. In auto mode, the system will 
select light source automatically according to the wavelength set. 

 
Scan Parameter 
 
Set the scan parameters including: 
 
Scan Interval (s) 
Set the scan interval when multiple scans will be performed and the unit is s. It can 
be set to any integer from 0 to 9999s and the default is 1. 
  
Scan Speed 
Select the speed of the scan (include slow, middle, fast and very fast). The slower 
the scan speed is, the closer the measured data will be to the actual value. The 
default is fast.  
  
WL Step (nm) 
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The step of the wavelength change during the scan. It can be set to 0.05, 0.1, 0.2, 
0.5, 1, 2 and 5, the unit is nm and the default is 1. 
  
Click OK when the method setup is finished and the software will directly enter the 
acquisition interface without saving the related settings; click Cancel and the 
method parameters will be restored to their default values. You can also click Save in 
the Method option under the File menu to save the new method to the default 
directory, or click Save As to save the new method to the specified directory using 
the specified name. 
 

 Tip: 

 If you want to use the method already exists instead of creating a new 
method, click Open in the Method option under the File menu to directly 
load the method already saved. 

 
 

4.1.3 To Send the Spectrum Measurement 

Method 
 
After setting the sample parameters, click Send Method under the Acquisition 
menu, UltraUV sends the method parameters to the instrument and the instrument 
receives and records the method parameters set. 
 

 Tip: 

 You need to send the method again if the method parameters are changed 
after sending the method; otherwise, the system will make measurement 
according to the previous method. 
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4.1.4 To Edit the Acquisition Table of the 

Spectrum Measurement  
 

Click at the left of the spectrum measurement interface or click 
OK after setting the method parameters of the spectrum measurement to enter the 
acquisition interface. The acquisition interface consists of the Acquisition Table 
Editing Area and the Real-time Scan Chromatogram Area which are used to 
edit the related parameters of the acquisition table and display the measured 
chromatogram respectively as shown in the figure below. 

 

 
Acquisition Table Editing Area 
Edit the acquisition table. If not, the baseline correction and measurement can not 
be performed. 
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Sample ID 
Set the name of the sample. If you do not set the sample ID, the default value will be 
used ("Sample" plus the line number, for example, Sample1). If single cell is selected, 
you can only set one sample; if 8-series multicell is used, up to 8 samples can be 
edited.  
 

Tip: 

 After setting the sample ID, press Enter on the keyboard to change to the 
next sample ID; press Tab  to directly switch to the cell ID input box (and so 
on); press the direction keys on the keyboard to make corresponding 
switches.  

  
Cell ID 
Select the cell number. The cell number can not be input manually and you need to 
select the cell number from the dropdown arrow in the input box. If single cell is 
selected, the cell ID can only be set to 1; if 8-series multicell is used, it can be set to 
1 to 8. 
  
Start WL or End WL 
Set the start wavelength or end wavelength when scanning the sample. They can be 
set to any integer between 190nm and 900nm and the defaults are 890nm and 
880nm respectively. Note that the start wavelength must be greater than the end 
wavelength (scan from long wave to short wave); otherwise, prompt message will be 
displayed when sending the method. As the absorbance of the sample at different 
wavelength is different, you are recommended to set the start wavelength and end 
wavelength according to the characteristics of the sample.  
  
Cycle Times 
Set the number of times of the scan of the sample and it can be set to any integer 
between 1 and 10.  
 
Sample Info 
Input the remark (explanatory description) of the sample, for example, the sample 
submitter, date of sample submitted, sample name, dilutability, standard sample or 
not and concentration.  
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File Name 
The name of the data file storing the measurement result after the measurement. If 
no data file name is specified, the measurement result will be stored in 
“Sample1Year-Month-Date-Hour-Minute-Second” format automatically.  
  

 Note: 

 You need to edit the acquisition table before executing spectrum 
measurement. 

 In spectrum measurement, up to 8 samples can be measured in one 
measurement and you will not be informed to change the sample during the 
measurement. 

 The data file name conforms to the Windows standard naming rules. Its 
length can not exceed 256 characters and the file name can be English 
letters, numbers, ￥＠＆＋（）, underscore, space and Chinese characters, 
but "：？\ * |  < > : /" can not be used.  

 

Tip: 

 When scanning the same sample, you only need to set the cycle times instead 
of setting the measurement method again. 

 
Real-time Scan Chromatogram Area 
The sample data changes accordingly during the measurement and the result 
acquired is displayed in this area in figure form accordingly. 
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4.1.5 To Execute the Baseline Correction of 

Spectrum Measurement 
 
Baseline correction sets the background within the wavelength range currently 
selected to zero and all the readings within this range will be affected. Baseline 
correction ensures better reference point in data acquisition.  
  

After setting the sample parameters, click  under the Acquisition menu, the 

instrument starts to execute baseline correction and the prompt dialog box is 
displayed. Baseline correction covers all the wavelengths, performs correction at 
certain scan speed and step and displays the current wavelength and the 
corresponding absorbance accordingly.  
 

Tip: 

 The baseline correction adopts 1nm wavelength step. 
 After finishing the baseline correction and closing the software, baseline 

correction is required at the next measurement, as the software does not 
record the last operation.  

 Execute baseline correction again when the slit width, scan speed, 
wavelength range, sample interval and the accessory of the sample operation 
changed.  

 Set the sample parameters before executing the baseline correction. During 
the correction, other operations are disabled.  

 

4.1.6 To Run Spectrum Measurement 
 
After the baseline correction is finished, click Run under the Acquisition menu, the 
instrument makes measurement according to the parameters set and the measured 
data is displayed in the Real-time Scan Chromatogram Area in curve form.  
  
After the measurement is finished, UltraUV switches to the chromatogram interface 
automatically. The measurement result is displayed at the right side of the interface 
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in chromatogram form. At the same time, the current wavelength and absorbance 
are displayed in the status bar in the main interface.  
 

Tip: 

 This function is only available after sending the method. 
 You can click Stop or Abort to stop the measurement during the 

measurement. 
 Do not turn off the software or the instrument during the measurement, 

otherwise, the measurement result will be lost and abnormal prompt 
message will be displayed at the next start-up of the software. 

 

4.1.7 To Stop Spectrum Measurement 
 
Click Stop or Abort under the Acquisition menu to stop the current measurement. 
The measurement stopped can not be resumed and you need to send the method 
again and restart the measurement.  
  
The difference between Stop and Abort 
 
Stop 
 
The instrument stops the measurement and saves the measurement data. The 
software switches to the chromatogram interface and you can process the spectrum 
data measured.  
  
Abort 
 
The instrument stops the measurement without saving the measurement data.  
 

Note: 

 The Stop or Abort operation is only available after sending the method and 
starting the measurement.  
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4.1.8 Chromatogram Processing of the Spectrum 

Measurement 
 

After the spectrum measurement finishes, the measurement results are saved in the 
default storage directory of the system and UltraUV switches to the 

interface automatically as shown in the figure on the next page. 
You can process the chromatogram measured and save the results (operation 
method: click Save in the Chroma option under the File menu to save the current 
chromatogram in the default directory; or click Save As to save the chromatogram 
under the specified directory using the specified name). Besides, you can also 
process the scan chromatogram saved (operation method: click Open in the 
Chroma option under the File menu to select the chromatogram to be processed). 
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Main topics: 

 Chromatogram Operations of Spectrum Measurement  

 Operation Result Detect of Spectrum Measurement  

 Chromatogram Display Setting of Spectrum Measurement  

 Follow-up Operations of Chromatogram  

 

Tip: 

 If no chromatogram is currently opened, chromatogram processing can not 
be performed. The chromatograms currently opened will be numbered and 
displayed in the navigation bar according to the order in which they are 
opened. You can click the numbers to switch among the chromatograms and 
at most, 16 curves can be displayed at the same time.  

 Click Close in the Chroma option under the File menu to close the current 
chromatogram; click Close All to close all the chromatograms opened.  
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4.1.8.1 Chromatogram Operations of Spectrum 

Measurement 
 

Operation types of spectrum measurement: 

 Interpolation  

 Datasets Operation  

 Arithmetic  

 Transform  

 Ensemble Average  

 

Tip: 

 All the operation types are not available when the measurement mode is E_S 
or E_R. 
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4.1.8.1.1 Interpolation 
 
Perform interpolation operation on the measurement result to get measurement 
values with relatively smaller sample interval. You need to set the related parameters 
after selecting the interpolation operation.  
  
Data 
  
Select the desired chromatogram. If no chromatogram is currently opened, the data 
list is blank and interpolation operation can not be performed. Click File and open a 
chromatogram from the Chroma option.  
  
Step 
  
Select the interval (0.05, 0.1, 0.2, 0.5 and 1). 
  
Calculate 
  
Click this button and the software calculates the interpolation automatically. The 
calculation result will be displayed in the Chromatogram Display Area in 
chromatogram form. To distinguish the chromatograms before and after the 
operation, the filename of the calculated chromatogram is "the file name of the Data 
plus the specific system time at the calculation” and the calculated chromatogram is 
marked with different color. When using the interpolation operation again, this 
chromatogram will appear in the Data list.  
 

Tip: 

 You can also click Interpolation under the Chroma menu to directly enter 
the interpolation setting menu. 

 Interpolation operation can not be performed when the interpolation interval 
is greater than the sample rate.  
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4.1.8.1.2 Datasets Operation 
 

Perform datasets operation on the chromatogram file measured. You need to set the 
related parameters when datasets operation is selected.  
  
DatasetA 
Select the chromatogramA for the datasets operation.  
 
Operation 
Select the operator ("+, -, *, /" corresponding to the buttons in the Multiple 
Chroma option under the Chroma menu, you can also click the corresponding 
button directly for shortcut setting).  
  
DatasetB 
Select the chromatogramB for datasets operation. 
 
Calculate 
Click this button and the software calculates automatically according to the setting. 
The calculation results will be displayed in the Chromatogram Display Area in 
chromatogram form. The filename of the calculated chromatogram is "the filename 
of DatasetA plus the specific system time at the calculation” and the calculated 
chromatogram is marked in different color. When you perform datasets operation 
again, this chromatogram will appear in the Data list.  
 

Note: 

  In data processing, the datasets arithmetic operation is only available for the 
same measurement mode (such as absorbance or transmittance).  

 Datasets arithmetic operation is only available for the intersection between 
the datasets. 

 For datasets operation, the datasets selected must have the same 
wavelength range and sample interval. 

 To perform the operation, DatasetA and DatasetB must be selected. 
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4.1.8.1.3 Arithmetic 
 
Perform arithmetic operation on the dataset measured and constant. You need to set 
the related parameters when arithmetic operation is selected.  
  
Data 
  
Select a chromatogram to perform arithmetic operation. 
  
Operation 
  
Select the operator ("+, -, *, /" corresponding to the buttons in the Multiple 
Chroma option under the Chroma menu, you can also click the corresponding 
button directly for shortcut setting).  
 
Constant 
  
Set the constant. The range is any integer between -100,000,000,000 and 100, 
000,000,000. If the constant input exceeds this range, the prompt message will be 
displayed after clicking Calculate.  

 

 
Calculate 
  
Click this button and the software calculates automatically according to the setting. 
The calculation results will be displayed in the Chromatogram Display Area in 
chromatogram form. The filename of the calculated chromatogram is "the filename 
of Data plus the specific system time at the calculation" and the calculated 
chromatogram is marked in different color. When you perform arithmetic operation 
again, this chromatogram will appear in the Data list.  
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4.1.8.1.4 Transform 
 
Perform transform between different measurement modes and save the result as a 
new file. You need to set the related parameters when transform is selected.  
 
Data 
  
Select the desired chromatogram.  
  
Transform 
  
The transform types available include Derivative, Logarithm, Reciprocal, T->Abs (or 
Abs->T), Pow, Square Root, ln and Exponential corresponding to the buttons in the 
Single Chroma area under the Chroma menu (you can also click the 
corresponding button directly for shortcut setting).  
 
Calculate 
  
Click this button and the software calculates automatically according to the setting. 
The calculation results will be displayed in the Chromatogram Display Area in 
chromatogram form. The filename of the calculated chromatogram is "the filename 
of Data plus the specific system time at the calculation" and the calculated 
chromatogram is marked in different color. When you perform transform operation 
again, this chromatogram will appear in the Data list.  

Note: 

 When the measurement mode is Abs, T->Abs transform is not available; 
when the measurement mode is T%, Abs->T transform is not available.  
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4.1.8.1.5 Ensemble Average 
 
Perform average on multiple chromatograms. You need to set the related 
parameters when ensemble average is selected.  
  
Op. Type 
  
Select Ensemble Average from the operation type dropdown box. You can also 
click ChromaAvg in the Multiple Chroma area for shortcut setting.  
  
Data 
  
Select the desired chromatogram from the Data dropdown box. At this point, the 
filenames of the chromatograms belonging to the same type with the chromatogram 
selected will be displayed in the textbox below. You can check the chromatograms 
for ensemble average.  
  
Calculate 
  
Click this button and the software calculates automatically according to the setting. 
The calculation results will be displayed in the Chromatogram Display Area in 
chromatogram form. The filename of the calculated chromatogram is "the filename 
of Data plus the specific system time at the calculation" and the calculated 
chromatogram is marked in different color. At the same time, the filename of this 
chromatogram will appear in the Data list and the textbox below.  
  

Note: 

 The chromatograms for the ensemble average must have the same 
measurement mode, wavelength range and step. 
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4.1.8.2 Operation Result Detect of Spectrum 

Measurement 
 

This section mainly introduces how to detect the measurement results. 
 

Detect modes: 

 Peak Pick Detect  

 Peak Area Detect  

 Point Pick Detect  

 

Note: 

 You must activate the corresponding detect mode before performing result 
detect. Operation method: click View in the menu bar and check the desired 
detect mode in the View option as shown in the figure below.  
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4.1.8.2.1 Peak Pick Detect 
 

The peak pick detect table, being displayed in the Result Detect Area of the 
chromatogram operation interface, displays all the peaks/valleys in the dataset as 
well as the wavelength and transmittance (or absorbance) of each peak/valley. After 
the measurement is finished, the system detects the peak/valley automatically and 
displays the results in the peak pick detect table as shown in the figure below.  

 

 
P/V Threshold 
  
The P/V threshold is the standard used to determine the peak and noise. Glitches can 
be filtered out if proper threshold is set. Input the desired threshold in the P/V 
threshold input box in the Peak Chroma option under the Chroma menu, the 
range is from 1e-7 to 100 and the default is 0.001.  
 

Tip: 

 The peak pick detect table would change with the P/V threshold. The greater 
the threshold is, the fewer peaks/valleys will be detected.  

 When the measurement mode is E_S or E_R, peak pick detect is not 
available. 
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4.1.8.2.2 Peak Area Detect 
 

Peak area is used to calculate the area of the region under the curve. Peak area can 
contain one or more regions and each region corresponds to one line in the peak 
area detect table which also includes the start wavelength and end wavelength used 
to define a region. Input the start wavelength and end wavelength of a region and 
the area column would return the area of that region. For any dataset opened, you 
can define desired number of regions for it.  
  
Click Area in the Result Detect Area and the peak area detect table will be 
displayed as shown in the figure (a) below. In Active mode, two reading lines will 
appear in the chromatogram display area as shown in the figure (b) and you can use 
the reading lines to define regions on the chromatogram or input the start 
wavelength and end wavelength manually in the peak area detect table; while in 
Overlay and Stacked modes, you can only input the start wavelength and end 
wavelength manually in the peak area detect table.  

Figure (a) 
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Figure (b) 
 
Directlin 
  
Connect the start wavelength point and the end wavelength point and calculate the 
area of the region formed by the curve and the connecting line. The area above the 
connecting line is positive and the area under the connecting line is negative. 
Therefore, the area calculated might be negative.  
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Baseline 
  
Area formed by the two reading lines, curve and the X axis. 
 
Divisor 
  
Used for the proportion calculation of the area and the default is 1. 
Result=Area/Divisor (the divisor can not be zero). 
  

Tip: 

 When switching between the Directlin and Baseline modes, the area 
calculated and the result will change accordingly. 

 When both E_S and E_R are selected as the measurement modes, both the 
E_S area and the E_R area will be displayed after inputting the start 
wavelength and end wavelength.  

 The range of the start wavelength and end wavelength is from the start value 
to the end value of the chromatogram curve and prompt message will be 
displayed if the wavelength input exceeds this range.  

 

 

4.1.8.2.3 Point Pick Detect 
 

Used to read the measurement values of the corresponding points on the data curve 
measured.   
  
Click Point Pick in the Result Detect Area and the point pick detect table as 
shown in the figure (a) below will be displayed. In Active mode, a reading line will 
appear in the chromatogram display area as shown in the figure (b). You can define 
different wavelength on the chromatogram using the reading line or input the 
wavelength manually in the point pick detect table; while in Overlay and Stacked 
modes, you can only input the wavelength manually in the point pick detect table.  
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Figure (a) 

Figure (b) 
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Tip: 

 When both E_S and E_R are selected as the measurement modes, both the 
sample energy and the reference energy will be displayed after inputting the 
wavelength (within the curve range).  

 Click at the upper right corner of the result detect area and you can also 

switch among the peak pick, peak area and point pick interfaces in the 
pop-up dialog box.  

 The wavelength range is from the start value to the end value of the 
chromatogram curve and prompt message will be displayed if the input 
wavelength exceeds this range.  

 

 

4.1.8.3 Chromatogram Display setting of Spectrum 

Measurement  
 

You can set the chromatogram interface for easier measurement results analysis. 
Besides, you can also perform some shortcut operations such as store and print. 
UltraUV supports three chromatogram display types (Active, Overlay and 
Stacked). 
 

Main topics: 

 Chromatogram Interface Setting  

 Active  

 Overlay  

 Stacked  

 
 
 
 
 



RIGOL Chapter 4 Measurement 

UltraUV User’s Guide 4-28 

4.1.8.3.1 Chromatogram Interface Setting  
 
After the data processing is finished, you can set the axis, curve background and the 
size of the chromatogram interface. For details, refer to the introductions below.  
  
Click View and you can perform the following settings in the View option. 

 
 
Cross Cursor 
  

When it is checked, the cross cursor appears on the chromatogram. Right-click in the 
chromatogram display area and select Show Point Values in the pop-up dialog box 
as shown in the figure (a) below. At this point, when the cross cursor is placed on the 
measured data point, the data filename of the curve and the axis values of that point 
will be displayed as shown in the figure (b). 

Figure (a) 
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Figure (b) 
 
Grid 
  

After it is checked, the grid is displayed and you can easily view the axis values of 
each data point.  
  

Scale Line 
  

After it is checked, the scale line will be displayed on the X axis and Y axis.  
  

 

Display Area 
  

Click Display Area and the display area dialog box is displayed. You can set the 
scaleplate automatically or manually adjust the axis range.  
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Automatic 
You can set X axis or Y axis to automatic. When it is checked, the corresponding 
setting field in the manual adjustment is disabled.  
 

Manual 
You can set the maximum and minimum values of the X axis and Y axis manually. 
The maximum and minimum values can not exceed the current coordinate range; 
otherwise, the following dialog box will be displayed.  
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4.1.8.3.2 Active 
 

Display the chromatogram currently measured or processed as shown in the figure 
below. 
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Tip: 

 In this mode, if you want to view a wavelength value in details, you can 
rotate the mouse wheel or select this region using the mouse to zoom out or 
in this region.  

 Click the number in the navigation bar to activate the corresponding 
chromatogram data currently displayed in the interface.  

 
 
Right-click in the chromatogram display area and you can perform a 
series of follow-up operations on the chromatogram via the pop-up 
dropdown list. For the details, refer to Follow-up Operations of 
Chromatogram. 
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4.1.8.3.3 Overlay 
 

All the images measured or opened overlap and are displayed in the same 
chromatogram in different colors. 

 

 

Tip: 

 In this mode, if you want to view a wavelength value in details, you can 
rotate the mouse wheel or select this region using the mouse to zoom out or 
in this region. 
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Right-click in the chromatogram display area and you can perform a 
series of follow-up operations on the chromatogram via the pop-up 
dropdown list. For the details, refer to Follow-up Operations of 
Chromatogram. 
 
 

4.1.8.3.4 Stacked 
 
Display all the images measured or opened in stacked form to facilitate your 
comparison of data as shown in the figure below. 
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Tip: 

 In this mode, if you want to view a wavelength value in details, you can 
rotate the mouse wheel or select this region using the mouse to zoom out or 
in this region.  

 Click at the upper right corner in the figure above to switch among 

Active, Overlay and Stacked Interfaces via the pop-up dialog box.  
 
Right-click in the chromatogram display area and you can perform a 
series of follow-up operations on the chromatogram via the pop-up 
dropdown list. For the details, refer to Follow-up Operations of 
Chromatogram. 
 
 

4.1.8.4 Follow-up Operations of Chromatogram 
 

Right-click in the chromatogram display area and you can perform a series of 
follow-up operations of the chromatogram via the pop-up dropdown list. 

 
 
Copy 
  
Click Copy and the current chromatogram will be copied onto the clipboard. You can 
easily use the current chromatogram for demonstration, report and writing. 
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Save Image As... 
  
Save the current chromatogram in the specified location. The formats supported 
include emf, PNG, Gif, Jpg and Bmp. 
  
Page Setup.../Print... 
  
If printer is currently connected to your computer, you can set the page format and 
print the current chromatogram.  
  
Show Point Values 
  
The axis values of the point will be displayed when the cross cursor is placed on the 
data point.  
  
Un-Zoom 
  
Restore the chromatogram zoomed in or out proportionately.  
  
Undo All Zoom/Pan 
  
Restore the chromatogram to the size before the zoom-in and zoom-out.  
  
Set Scale to Default 
  
Restore the chromatogram to the default size. 
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4.2 Kinetic Measurement 
 

In kinetic measurement, system samples data continuously at certain time 
interval and displays the data sampled in figure form. It is mainly used to measure 
the absorbance or transmittance of the sample that changes with time at certain 
wavelength. The measurement result is the variation curve of the absorbance, 
transmittance or energy of the sample with the time at certain wavelength.  
  
In kinetic measurement, you can view the variation tendency of the sample with the 
time. It is usually used to measure the variation fluctuation of the material during 
some chemical reactions and determine within which period of time new material is 
generated according to the fluctuation. 
 
 

Main topics: 

 Kinetic Measurement Procedures 

 To Create Kinetic Measurement Method  

 To Send the Kinetic Measurement Method  

 To Edit the Acquisition Table of Kinetic Measurement  

 To Execute the Auto Zero of Kinetic Measurement  

 To Run Kinetic Measurement  

 To Stop Kinetic Measurement  

 Chromatogram Processing of Kinetic Measurement  
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4.2.1 Kinetic Measurement Procedures 
 

 
 

 

4.2.2 To Create Kinetic Measurement Method 
 
Set the method parameters before performing kinetic measurement. By default, the 
software enters the UltraUV-kinetic measurement interface at start-up. You 
can create a new method or open a method already exists through this interface.  
 
 
Create Method 
  
To create a new method, click New under the File menu. The message dialog box 
will be displayed querying whether to save the current kinetic method as shown in 
the figure below; click Yes to save the method in the specified directory and restore 
the method parameters to their default values; click No to abandon the current 
kinetic method and restore the method parameters to their default values 
automatically.  
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Tip: 

 You can also set or modify the method parameters directly without clicking 
New. 

 If no method parameter is set, the default method parameters will be used 
during the measurement. 

 
Set the Method Parameters 
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Measurement Mode 
  
The kinetic measurement supports four measurement modes (Abs (absorbance), 
T% (transmittance), E_S (sample energy) and E_R (reference energy)). When 
integrating sphere is used, the R% (reflectance) mode is also available. Wherein, 
E_S and E_R modes can be selected at the same time. 
  
Abs 
Measure the sample’s absorption degree of the light (the absorption of different 
sample of the light is different). 
  
T% 
Measure the absorption of the material of the light. The calculation formula is as 
follows. 
Abs=-log T=-log (Es/Er)      
Wherein, Es represents the sample energy and Er represents the reference energy.  
 

Note: 

 The calculated absorbance should be the same with that displayed at the 
bottom of the interface. 

 When the sample cell is hollow, the transmittance measured should be 
between 100.3% and 99.7% (specification: ±0.3％T). 

 
 
E_S or E_R 
Energy mode (sample energy or reference energy). After selecting this method, the 
PMT Voltage and Light Source Selection dialog box will be displayed at the right 
side and you need to set the PMT voltage and select the light source.  
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PMT Voltage and Light Source Selection: 
 

Auto 
When it is selected, the instrument will select voltage for the PMT automatically. 

 
Manual 
When it is selected, you need to set the PMT voltage manually. The range is from 0V 
to 1000V and the default is 380V. 

 
Light 
Select the PMT light source. It can be set to D2 (deuterium lamp), W (tungsten 
lamp), OFF (do not use light source) and Auto. 
 

Tip: 

 The PMT working voltage is related to the PMT gain. The service life of the 
PMT will be affected when it works under high working voltage for long 
periods of time and high working voltage can only be used when the energy 
measured is less than a certain degree. 

 You are recommended to use auto light source. In auto mode, the system will 
select light source automatically according to the wavelength set. 

 
 
Common 
  
Set the method parameters including: 
  
WL (nm) 
Set the wavelength point of kinetic measurement. It can be set to any integer from 
190nm to 900nm and the default is 880nm. In kinetic measurement, the system 
samples data at this wavelength point continuously.  

  
Sample Num 
Set the number of samples for each measurement. When single cell is used, the 
sample number is 1 by default and the input box is not available; when 8-series 
multicell is used, you can set the sample number and the range is from 1 to 8.  
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Delay Time (s) 
Set the time that the system waits before running the measurement. The range is 
from 0s to 24h (integer) and the unit is s (second). When the input exceeds this 
range or contains characters rather than numbers, prompt message will be displayed.  
   
Period (s) 
The time needed for a complete sample. The unit is s. The range of the period is 
related to the option used and the number of samples to be measured.  
When single cell is used, the period range is from 0.1s to 500.0s (with accuracy of 
one decimal place); 
When 8-series multicell is used, the period range is from 15.0s to 1000.0s (with 
accuracy of one decimal place). 
  
Cycle Times 
The number of sample points. It can be set to any integer from 0 to 15000. 
 
Click OK when the method setup is finished and the software will directly enter the 
acquisition interface without saving the related settings; click Cancel and the 
method parameters will be restored to their default values. You can also click Save in 
the Method option under the File menu to save the new method to the default 
directory, or click Save As to save the new method to the specified directory using 
the specified name.  
 

Tip: 

 The measurement acquisition time does not contain the delay time and are 
calculated from the start of the measurement. 

 If the period set is too short or the number of samples is too large, some of 
the samples might not be measured or the measurement accuracy might be 
affected. 

 If you want to use the method already exists instead of creating a new 
method, click Open in the Method option under the File menu to directly 
load the method already saved. 
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4.2.3 To Send the Kinetic Measurement Method 
 
After setting the sample parameters, click Send Method under the Acquisition 
menu, UltraUV sends the method parameters to the instrument and the instrument 
receives and records the method parameters set. 
 

Tip: 

 You need to send the method again if the method parameters are changed 
after sending the method; otherwise, the system will make measurement 
according to the previous method. 

 

 

4.2.4 To Edit the Acquisition Table of Kinetic 

Measurement 
 

Click at the left of the kinetic measurement interface or click OK 
after setting the method parameters of the kinetic measurement to enter the 
acquisition interface. The acquisition interface consists of the Acquisition Table 
Editing Area and the Real-time Scan Chromatogram Area which are used to 
edit the related parameters of the acquisition table and display the measured 
chromatogram respectively as shown in the figure below.  
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Acquisition Table Editing Area 
  
Edit the acquisition table. If not, the auto zero and measurement can not be 
performed.  
  
Sample ID 
Set the name of the sample. If you do not set the sample ID, the default value will be 
used ("Sample" plus the line number, for example, Sample1). If single cell is used, 
you can only set one sample; if 8-series multicell is used, up to 8 samples can be 
edited. 
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Tip: 

 After setting the sample ID, press Enter on the keyboard to change to the 
next sample ID; press Tab  to directly switch to the cell ID input box (and so 
on); press the direction keys on the keyboard to make corresponding 
switches. 

 
Cell ID 
Select the cell number. The cell number can not be input manually and you need to 
select the cell number from the dropdown arrow in the input box. If single cell is used, 
the cell ID can only be set to 1; if 8-series multicell is used, it can be set to 1 to 8. 
 
Sample Info 
Input the remark (explanatory description) of the sample, for example, the sample 
submitter, date of sample submitted, sample name, dilutability, standard sample or 
not and concentration.  
 
File Name 
The name of the data file storing the measurement result after the measurement. If 
no data file name is specified, the measurement result will be stored in 
“Sample1Year-Month-Date-Hour-Minute-Second” format automatically.  
 

Note: 

 You need to edit the acquisition table before executing kinetic measurement. 
 In kinetic measurement, up to 8 samples can be measured at the same time 

and you will not be informed to change the sample during the measurement. 
 The data file name conforms to the Windows standard naming rules. Its 

length can not exceed 256 characters and the filename can be English letters, 
numbers, ￥＠＆＋（）, underscore, space and Chinese characters, but "：？

\ * |  < > : /" can not be used.  
 
 
 
 
 



RIGOL Chapter 4 Measurement 

UltraUV User’s Guide 4-46 

Real-time Scan Chromatogram Area 
The sample data changes accordingly during the measurement and the result 
acquired is displayed in this area in figure form accordingly.  

 

 
 

4.2.5 To Execute the Auto Zero of Kinetic 

Measurement 
 
In auto zero, the system samples at a certain sample rate and averages the points 
sampled during specified period. This average value is taken as the zero value which 
needs to be subtracted from all the measurement values.  
  

After setting the sample parameters, click under the Acquisition menu and the 
instrument performs auto zero. The dialog box as shown in the figure below will be 
displayed after the auto zero is finished.  
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Note: 

 Auto zero must be performed to adjust the output to zero before each kinetic 
measurement; otherwise, the measurement accuracy might be affected. 

 Other operations are unavailable during auto zero. 
 

Tip: 

 When the measurement mode is E_S or E_R, the sample energy or 
reference energy will not be affected by auto zero. 

 If the software is closed or the instrument is disconnected during auto zero, 
the dialog box as shown in the figure below will be displayed at the next 
start-up of the software and connection of the instrument. 
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4.2.6 To Run Kinetic Measurement 
 
After auto zero is finished, click Run under the Acquisition menu, the instrument 
makes measurement according to the parameters set and the measured data is 
displayed at the lower part of the interface in curve form. 
After the measurement is finished, UltraUV switches to the chromatogram interface 
automatically. The measurement result is displayed at the right side of the interface 
in chromatogram form. You can also click Run to perform measurement again using 
the current settings. At the same time, the current wavelength and absorbance are 
displayed in the status bar in the main interface.  
 

Note: 

 This function is only available after sending the method. 
 You can click Stop or Abort to stop the measurement during the 

measurement. 
 Do not close the software or turn off the instrument during the measurement, 

otherwise, the measurement result will be lost and abnormal prompt 
message will be displayed at the next start-up of the software. 

 
 

4.2.7 To Stop Kinetic Measurement 
 
Click Stop or Abort under the Acquisition menu to stop the current measurement. 
The measurement stopped can not be resumed and you need to send the method 
again and restart the measurement.  
 

The difference between Stop and Abort 
  
Stop 
 
The instrument stops the measurement and saves the measurement data. The 
software switches to the chromatogram interface and you can process the data 
measured.  
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Abort 
 
The instrument stops the measurement without saving the measurement data and 
you need to send the method again and run the measurement.  
 

Note: 

 The Stop or Abort operation is only available after sending the method and 
starting the measurement. 

 
 

4.2.8 Chromatogram Processing of Kinetic 

Measurement 
 

After the kinetic measurement finishes, the measurement results are saved in the 
default storage directory of the system and UltraUV switches to the 

interface automatically as shown in the figure below. You can 
process the chromatogram measured and save the results. Besides, you can also 
process the scan chromatogram saved (operation method: click Open in the 
Chroma option under the File menu to select the chromatogram to be processed). 
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Tip: 

 If no chromatogram is currently opened, chromatogram processing can not 
be performed. The chromatograms currently opened will be numbered and 
displayed in the Navigation Bar according to the order in which they are 
opened. You can click the numbers to switch among the chromatograms and 
at most, 16 curves can be displayed at the same time. 

 
 
The processing method of kinetic measurement is similar to that of 
spectrum measurement. For details, refer to "Chromatogram Processing 
of Spectrum Measurement". 
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4.3 Photometric Measurement 
 
In photometric measurement, the system measures the absorbance and 
transmittance of the sample at the specified wavelength and the measurement result 
is the absorbance (transmittance or energy) of the sample at the specified 
wavelength. You can specify multiple wavelength points (at most 10) for photometric 
measurement and can perform simple math operations on the data measured. 
 
 

Main topics: 

 Photometric Measurement Procedures  

 To Create Photometric Measurement Method  

 To Send the Photometric Measurement Method  

 To Edit the Acquisition Table of Photometric Measurement  

 To Execute the Auto Zero of Photometric Measurement  

 To Run Photometric Measurement  

 To Stop Photometric Measurement  

 Data Processing of Photometric Measurement  
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4.3.1 Photometric Measurement Procedures 
 

The photometric measurement procedures of UltraUV are as follows. 
 

 

 

 

4.3.2 To Create Photometric Measurement 

Method 
 
Set the method parameters before performing photometric measurement. Click 

to activate the photometric measurement window and by default, 
the software switches to the method setting interface of photometric 
measurement. You can create a new method or use the method already exists 
through this interface.  
 
Create Method 
  
To create a new method, click New under the File menu. The message dialog box 
will be displayed querying whether to save the current photometric method as shown 
in the figure below; click Yes to save the method in the specified directory and 
restore the method parameters to their default values; click No to abandon the 
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current photometric method and restore the method parameters to their default 
values automatically.  

 

Tip: 

 You can also set or modify the method parameters directly without clicking 
New. 

 If no method parameter is set, the default method parameters will be used 
during the measurement. 

 
Set the Method Parameters 

 

 
Method Info 
  
File Name 
Display the storage directory and filename of the method created. 
 
 



RIGOL Chapter 4 Measurement 

UltraUV User’s Guide 4-54 

Describe 
Describe the method created. 
  
Note 
Add explanation (such as the measurement settings and sample information) of the 
method edited. 
  
Measurement Mode 
  
The kinetic measurement supports two measurement modes (Abs (absorbance) and 
T% (transmittance)). When integrating sphere is used, the R% (reflectance) mode 
is also available.  
  
Abs 
Measure the sample’s absorption degree of the light (the absorption of different 
sample of the light is different). 
  
T% 
Measure the absorption of the material of the light. The calculation formula is as 
follows. 
Abs=-log T=-log (Es/Er)      
Wherein, Es represents the sample energy and Er represents the reference energy.  
  

Note: 

 The calculated absorbance should be the same with that displayed at the 
bottom of the interface. 

 When the sample cell is hollow, the transmittance measured should be 
between 100.3% and 99.7% (specification: ±0.3％T). 

 The two measurement modes can not be selected at the same time. 
 
Repeatedly Measurement 
  
In photometric measurement, you can make repeated measurements on the same 
sample.  
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Interval (s) 
Set the time interval between measurements when performing repeated 
measurements on the sample. The range is from 0 to 86400s (integer). When the 
time interval is 0, the system will measure continuously.  
 
Wavelength 
 
WL Num (1-10) 
Set the number of wavelength points for measurement and up to 10 wavelengths 
can be set.  

  
WLn (nm) 
Set the wavelength to be measured. The corresponding number of wavelength 
setting boxes of the wavelength points to be measured will be displayed. The range 
of the wavelength is from 190nm to 900nm. 
 
Click OK when the method setup is finished and the software will directly enter the 
acquisition interface without saving the related settings; click Cancel and the 
method parameters will be restored to their default values. You can also click Save 
in the Method option under the File menu to save the new method to the default 
directory, or click Save As to save the new method to the specified directory using 
the specified name.  
 

Tip: 

 If you want to use the method already exists instead of creating a new 
method, click Open in the Method option under the File menu to directly 
load the method already saved. 
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4.3.3 To Send the Photometric Measurement 

Method 
 
After setting the sample parameters, click Send Method under the Acquisition 
menu, UltraUV sends the method parameters to the instrument and the instrument 
receives and records the method parameters set.  
 

 Tip: 

 You need to send the method again if the method parameters are changed 
after sending the method; otherwise, the system will make measurement 
according to the previous method.  

 
 

4.3.4 To Edit the Acquisition Table of 

Photometric Measurement 
 

Click at the left of the photometric measurement interface or click 
OK after setting the method parameters of the photometric measurement to enter 
the acquisition interface. The acquisition interface consists of the Acquisition Table 
Editing Area and the Data Real-time Display Area which are used to edit the 
related parameters of the sample and display the measured data respectively as 
shown in the figure below. 
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Acquisition Table Editing Area 
  
Edit the acquisition table. If not, the auto zero and measurement can not be 
performed.  
  
Sample ID 
Set the name of the sample. If you do not set the sample ID, the default value will be 
used ("Sample" plus the line number, for example, Sample1). 
 
Cell ID 
Select the cell number. The cell number can not be input manually and you need to 
select the cell number from the dropdown arrow in the input box. If single cell is used, 
the cell ID can only be set to 1; if 8-series multicell is used, it can be set to 1 to 8. 
  
Batch 
In photometric measurement, you can measure the samples in multiple cells in the 
same measurement, therefore, batch measurement is required. The batch of the 
sample is determined by the cell ID (the batch increments automatically when the 
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cell ID is edited) and you can not edit it. The batch range is from 1 to 20.  
  
Cycle Times 
Set the number of measurements performed on the sample at a certain wavelength 
and at most 100 measurements can be performed. If the cycle times input exceeds 
this range, it will be automatically modified to 100 and the message dialog box will 
be displayed. After the measurement is finished, the result of each measurement will 
be displayed in table form in order.  
 
Sample Info 
Input the remark (explanatory description) of the sample, for example, the sample 
submitter, date of sample submitted, sample name, dilutability, standard sample or 
not and concentration. 
 
Data Save As 
After the measurement is finished, click Data Save As above the sample setting 
area to store the parameters set in the specified directory with the specified filename.  
 

 Note: 

 You need to edit the acquisition table before executing photometric 
measurement. 

 The data file name conforms to the Windows standard naming rules. Its 
length can not exceed 256 characters and the filename can be English letters, 
numbers, ￥＠＆＋（）, underscore, space and Chinese characters, but "：？

\ * |  < > : /" can not be used. 
 

 Tip: 

 After setting the sample ID, press Enter on the keyboard to change to the 
next sample ID; press Tab  to directly switch to the cell ID input box (and so 
on); press the direction keys on the keyboard to make corresponding 
switches. If single cell is used, you can only set one sample; if 8-series 
multicell is used, up to 8 samples can be edited. 

 For scanning of the same sample, you only need to set the cycle times rather 
than setting the measurement method again.  
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Data Real-time Display Area 
During the measurement, the data measured will be displayed in this area in table 
form.   

 
 
 

4.3.5 To Execute the Auto Zero of Photometric 

Measurement  
 

In auto zero, the background within the wavelength range currently selected is set 
to zero and all the readings within this range will be affected. Auto zero ensures a 
better reference point for data acquisition.  
  

After setting the sample parameters, click under the Acquisition menu and the 

instrument performs auto zero. The dialog box as shown in the figure on the next 
page will be displayed after the auto zero is finished.  
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 Note: 

 Auto zero must be performed to adjust the output to zero before each 
photometric measurement; otherwise, the measurement accuracy might be 
affected.  

 Other operations are unavailable during auto zero. 
 

 Tip: 

 If the software is closed or the instrument is disconnected during auto zero, 
the dialog box as shown in the figure below will be displayed at the next 
start-up of the software and connection of the instrument. 

 
 
 

4.3.6 To Run Photometric Measurement 
 
After auto zero is finished, click Run under the Acquisition menu, the instrument 
makes measurement according to the parameters set and the measured data is 
displayed at the Data Real-time Display Area in table form.  
  

When multiple samples are measured, the dialog box as shown in the figure below 
will be displayed to inform you to change the sample after the measurement of the 
current sample is finished.  

 

After the measurement is finished, the dialog box informing you that the 
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measurement is finished will be displayed; click OK and the instrument will switch to 
the data processing interface automatically. The measurement results will be 
displayed at the right side of the interface in table form. 

 Note: 

 If you do not change the sample and click OK directly, the instrument will 
continue to measure the previous sample and the measurement results will 
be affected. 

 Do not close the software or turn off the instrument during the measurement; 
otherwise, the measurement results will be lost and abnormal prompt 
message will be displayed at the next start-up of the software. 

 

 Tip: 

 This function is only available after sending the method. 
 You can click Stop or Abort to stop the measurement during the 

measurement. 
 
 

4.3.7 To Stop Photometric Measurement 
 
Click Stop or Abort under the Acquisition menu to stop the current measurement.  
 
  
The difference between Stop and Abort 
  
Stop 
 
The instrument stops the measurement and saves the measurement data. The 
software switches to the data processing interface and you can view the photometric 
data measured. If the measurement table is complete, you can also process the 
photometric data. 
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Abort 
 
The instrument stops the measurement without saving the measurement data. You 
need the send the method and run the measurement again. 
 

 Note: 

 The Stop or Abort operation is only available after sending the method and 
starting the measurement. 

 If you stop the photometric measurement during the measurement process, 
this measurement can not be resumed and you need to run the measurement 
again. 

 
 

4.3.8 Data Processing of Photometric 

Measurement 
 
When the photometric measurement is finished, the data measured will be stored in 
the default storage directory of the system and UltraUV will switch to the 

interface automatically as show in the figure below. You can process 
the data measured and save the results (operation method: click Save in the Data 
option under the File menu to save the current data processing result in the default 
directory; or click Save As to save the result in the specified directory with the 
specified name). Besides, you can also process the data already saved (operation 
method: click Open in the Data option under the File menu to select the desired 
data file). 



Chapter 4 Measurement RIGOL 

UltraUV User’s Guide 4-63 

 
 
This part is mainly used to perform various operations on the data measured and the 
results are displayed in the Data Processing Area accordingly. Photometric 
measurement supports the following operations.  

 Datasets Operation  

 Arithmetic  

 Transform  

 Ensemble Average  

 RSD  

 Custom  

 

Data Info 

Display the storage directory and filename of the data file currently processed.  
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4.3.8.1 Datasets Operation 
 
Perform datasets operation on the photometric data measured. You need to set the 
related parameters after datasets operation is selected as shown in the figure below.  

  
 
New Column 
  
Set the name of the column of the operation result. If no column name is set, the 
column name is the “Column plus the column number" by default, such as Column1. 
  
DataA 
  
Select the name of the column for the datasets operation from the dropdown list. 
  
Operation 
  
Select the operator from the dropdown list and the operators include "+, - , *, /". 
  
DataB 
  
Select the name of the column for the datasets operation from the dropdown list.  
 
Calculate 
  
Click this button and the software calculates according to the setting automatically. 
The operation result will be displayed in the Data Processing Area in a new 
column (next to the last column of the measurement data table).  
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 Tip: 

 To make the operation, DataA and DataB must be selected. 
 Click Close in the Data option under the File menu to close the data file 

currently processed.  
 

 

4.3.8.2 Arithmetic 
 

Perform arithmetic operation on the data measured and constant. You need to set 
the related parameters when arithmetic operation is selected as shown in the figure 
below.  

 
 
New Column 
  
Set the name of the column of the operation result. If no column name is set, the 
column name is the “Column plus the column number" by default, such as Column1. 
  
Data 
  
Select the name of the column for the arithmetic operation.  
  
Operation 
  
Select the operator from the dropdown list and the operators include "+, - , *, /". 
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Constant 
  
Set the constant and it can be any integer from -100,000,000,000 to 100, 
000,000,000. If the constant input exceeds this range, the prompt message as 
shown in the figure on the next page will be displayed after clicking Calculate.  
 

 

 
Calculate 
  
Click this button and the software calculates according to the setting automatically. 
The operation result will be displayed in the Data Processing Area in a new 
column (next to the last column of the measurement data table). 
 
 

4.3.8.3 Transform 
 

Perform measurement mode transform and save the result as a new file. You need to 
set the related parameters when transform is selected as shown in the figure below. 
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New Column 
  
Set the name of the column of the operation result. If no column name is set, the 
column name is the “Column plus the column number" by default, such as Column1. 
 
Data 
  
Select the name of the column for the transform operation. 
  
Transform 
  
Select the transform type (include Logarithm, Reciprocal, T->Abs (or Abs->T), Pow, 
Square Root, ln and Exponential). 
 
Calculate 
  
Click this button and the software calculates according to the setting automatically. 
The operation result will be displayed in the Data Processing Area in a new 
column (next to the last column of the measurement data table). 
 

 Tip: 

 The name of the new column will appear in the Data dropdown list after the 
operation. 

 If you click Calculate again after the operation is finished, the previous 
operation result will not be overwritten or cleared and the current operation 
result will be displayed in a new column ( next to the last column of the 
table), and so on. 

 When the measurement mode is Abs, T->Abs transform is not available; 
when the measurement mode is T%, Abs->T transform is not available. 
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4.3.8.4 Ensemble Average 
 

Calculate the average of the measurement values of multiple measurements of the 
same sample in the measurement result table. 

 

 
To calculate the average of the measurement results of multiple measurements of 
the same sample in the same batch and the same sample cell, click Calculate. The 
operation result will be displayed in the next line of the last measurement of each 
batch as shown in the figure on the next page. 
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4.3.8.5 RSD 
 

Calculate the relative standard deviation of the measurement results of multiple 
measurements of the same sample. 

 

 
To calculate the relative standard deviation of the measurement results of multiple 
measurements of the same sample in the same batch and the same sample cell, click 
Calculate. The operation result will be displayed in the next line of the last 
measurement of each batch as shown in the figure on the next page. 
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4.3.8.6 Custom 
 

You can also perform user-defined operation on the measurement results. 

 

 
New Column 
  
Set the name of the column of the operation result. If no column name is set, the 
column name is the “Column plus the column number" by default, such as Column1. 
  
Expression 
  
Define the desired operation expression. Click the Expression textbox and the 
Equation Editor panel as shown in the figure on the next page is displayed. 
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Select Column 
Select the column for the operation in the dropdown list. 
  
Front Delete 
Delete the character at the left of the cursor. 
  
Behind Delete 
Delete the character at the right of the cursor. 
  
Clear Equation 
Delete all the characters. 
  
OK 
Apply the expression edited. 
  
Cancel 
Cancel this operation. 
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4.4 Quantitation Measurement 
 

In quantitation measurement, the measurement value of the sample to be 
measured is compared to the standard curve to calculate the concentration of the 
sample to be measured, namely draw a absorbance-concentration relation curve 
according to the absorbance of the sample with known concentration, then measure 
the Abs value of the sample to be measured under the same conditions and 
calculate the concentration of the sample to be measured according to the 
Lambert-Beer law (the absorption of the material of the light is positively 
proportional to the concentration of the material) and the standard curve.   
  
Quantitation measurement is mainly used to measure the concentration of the 
sample to be measured on the basis of the measurement result of the standard 
sample concentration.  
 
 

Main topics: 

 Quantitation Measurement Procedures  

 To Create Quantitation Measurement Method  

 To Send the Quantitation Measurement Method  

 To Edit the Acquisition Table of Quantitation Measurement  

 To Execute the Auto Zero of Quantitation Measurement  

 To Run Quantitation Measurement  

 To Stop Quantitation Measurement  

 Data Processing of Quantitation Measurement  
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4.4.1 Quantitation Measurement Procedures 
 
The procedures of quantitation measurement of UltraUV are as follows. 

 
 

 

4.4.2 To Create Quantitation Measurement 

Method 
 
Set the method parameters before performing quantitation measurement. Click 

to activate the quantitation measurement interface and the 
software switches to the method setting interface of quantitation measurement by 
default. You can create a new method or use the method already exists through this 
interface.  
 
  
Create Method 
  
To create a new method, click New under the File menu. The message dialog box 
will be displayed querying whether to save the current quantitation method as shown 
in the figure below; click Yes to save the method in the specified directory and 
restore the method parameters to their default values; click No to abandon the 
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current kinetic method and restore the method parameters to their default values 
automatically.  

 

Tip: 

 You can also set or modify the method parameters directly without clicking 
New when connecting the instrument for the first time. 

 If no method parameter is set, the default method parameters will be used 
during the measurement. 

 
 
Set the Method Parameters 
  
Quantitation measurement supports multiple quantitation types. The method 
parameters and the calibration curve parameters to be set differ when different 
quantitation type is selected. 
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Method Parameter 
 
Type 
Click the type dropdown box to select the desired quantitation type including:  
  

Single 
Draw a standard curve between one point and the zero point. 
 
Multiple 
Draw a standard curve on the basis of multiple data points. 
  
K-Factor 
You can define the formula coefficient according to your need. 
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Logging Data 
Input data manually to draw a standard curve. 
  
Logging Standard Data 
Only support *.std file. 
  

Unit 
Set the concentration unit of the sample and the default is mg/l. If the quantitation 
type selected is Logging Standard Data, the unit can not be set.  

 
Formula 
Select the operation formula of quantitation measurement. If the quantitation type 
selected is Logging Standard Data, the formula not be set. The formulas available 
include: 

  
Single-WL 
Scan the sample at the single wavelength point set (it can be any integer from 
190nm to 900nm). When single wavelength is selected, you only need to set one 
wavelength point (WL1). 
 
Dual-WL Factor 
Measure the absorbance of the material. When dual wavelength factor is selected, 
you need to set two wavelength points (WL1 and WL2; they can be set to any 
integer from 190nm to 900nm) and the factor (it can be set to any integer 
between -99999 to 999999). 
 
Measurement Principle: eliminate the effects of the interfering component by 
calculating the difference of the absorbance under two wavelengths. Measure the 
absorbance (A1) of the solvent under the wavelength WL1, then measure the 
absorbance (A2) of the solvent under the wavelength WL2; multiply A2 with a 
factor (user-defined) and subtract the result from A1 to get the absorbance of the 
material.   
 
Dual-WL 
Measure the absorbance of the material. You need to set two wavelength points 
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(WL1 and WL2; they can be any integer from 190nm to 900 nm) when dual 
wavelength mode is selected.  
 
Measurement Principle: eliminate the effects of the interfering component by 
calculating the difference of the absorbance under two wavelengths.  Measure 
the absorbance (A1) of the solvent under the wavelength WL1, then measure the 
absorbance (A2) of the solvent under the wavelength WL2; subtract A2 from A1 to 
get the absorbance of the material.  
 
Three-WL 
Measure the absorbance of the material. You need to set three wavelength points 
(WL1, WL2 and WL3; they can be any integer from 190nm to 900nm). 
Compared to dual wavelength mode, three wavelength mode provides better 
sensitivity and accuracy.  
 
Measurement Principle: when the absorption of interfering components 
occurs, select three wavelength points of the component under test that have 
linear absorption and calculate the content of the component using arithmetic 
operation.  
 
 

Calibration Curve 
  
The standard curve is used to calculate the concentration of the unknown sample. 
Draw an Absorbance-Concentration curve (called the standard curve) by 
measuring the absorbance of the sample with known concentration. You need to set 
the following parameters. 
 
Conc=f (Abs) 
Calculate the concentration by taking the absorbance as the variable, for example, 
A=K1*C+K0. Note: in k-Factor, this option is not available.  
 
Abs=f (Conc)  
Mainly used to calculate the absorption factor. This is the inverse function of the one 
above. For example, C=K1*A+K0. Note: in k-Factor, this option is not available.  
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Curve Order 
Represent the order of the equation of the calibration curve and it can also be called 
exponent number. The curve orders available include: 
  

1st 
The standard curve is displayed as a first-order curve (also called linear equation). 
Note: in Single mode, the default curve order is 1st and can not be modified.  
 
2nd 
The standard curve is displayed as a quadratic curve.  
 
3rd 
The standard curve is displayed as a cubic curve.  
  

Zero Intercep 
When it is checked, the standard curve passes the zero point. Note: this option is 
only available in Multiple, Logging Data and Logging Standard Data.  
 
Click OK when the method setup is finished and the software will directly enter the 
acquisition interface without saving the related settings; click Cancel and the 
method parameters will be restored to their default values. You can also click Save in 
the Method option under the File menu to save the new method to the default 
directory, or click Save As to save the new method to the specified directory using 
the specified name. 
 

 Tip: 

 After clicking OK, the method parameters can not be modified. To modify 
them, click New to create a new method. 

 If you want to use the method already exists instead of creating a new 
method, click Open in the Method option under the File menu to directly 
load the method already saved 
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4.4.3 To Send the Quantitation Measurement 

Method 
 
After setting the sample parameters, click Send Method under the Acquisition 
menu, UltraUV sends the method parameters to the instrument and the instrument 
receives and records the method parameters set. 
 

 Tip: 

 You need to send the method again if the method parameters are changed 
after sending the method; otherwise, the system will make measurement 
according to the previous method. 

 
 

4.4.4 To Edit the Acquisition Table of 

Quantitation Measurement  
 

Click at the left of the quantitation measurement interface or click 
OK after setting the method parameters of the quantitation measurement to enter 
the acquisition interface as shown in the figure below. 
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Data Save As 
 
After the method is sent, the default storage directory and filename of the data will 
be displayed. You can also click Data Save As to store the data measured in the 
specified directory with the specified filename.  
 

 Note: 

 The data file name conforms to the Windows standard naming rules. Its 
length can not exceed 256 characters and the filename can be English letters, 
numbers, ￥＠＆＋（）, underscore, space and Chinese characters, but "：？

\ * |  < > : /" can not be used. 
 You need to edit the acquisition table before executing quantitation 

measurement. 
 The standard table and sample table can not be activated or disabled at the 

same time. Auto zero and measurement can not be made if the sample table 
is not edited. 
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Standard Table 
 
Edit the acquisition table of the standard sample table. The standard table is the data 
table obtained by sampling the material with known concentration under a single or 
multiple wavelengths. You can edit the parameters in the table after the standard 
table is activated.  
 
Sample Table 
 
Edit the acquisition table of the sample table. You can edit the parameters after the 
sample table is activated. The editing methods of the two tables are the same and in 
the following part, the standard table is taken as an example for illustration.  
 
Blank 
When it is check, the blank value will be subtracted from this point.  
  
Sample ID 
Set the name of the sample. If no sample ID is set, the default value (Sample plus 
line number, such as Sample1) will be used.  
 
Cell ID 
Select the cell number. The cell number can not be input manually and you need to 
select the cell number from the dropdown arrow in the input box. If single cell is used, 
the cell ID can only be set to 1; if 8-series multicell is used, it can be set to 1 to 8. 
  
Batch 
In quantitation measurement, you can measure the samples in multiple cells in the 
same measurement; therefore, batch measurement is required. The batch of the 
sample is determined by the cell ID (the batch increments automatically when the 
cell ID is edited) and you can not edit it. The batch range is from 1 to 20. 
 
Concentration 
Set the concentration of the sample. Auto zero and measurement can not be 
performed if the sample concentration is not set.  
 
WLXXX (XXX represents the wavelength point) 
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Set the absorbance of the sample at the corresponding wavelength point (such as 
WL880). 
  
Result 
The final absorbance of the sample. The calculation formula is as follows. 
 
Single 

1AAbs =  

Dual-WL 
21 A-AAbs =  

Dual-WL Factor K•= 21 A-AAbs  

Three-WL ( ) ( )[ ] ( )313211322 W-WAW-WAW-W-AAbs ÷×+×=  

 
Wherein, Abs is the final absorbance; W1 is wavelength1; W2 is wavelength2; W3 is 
wavelength3; A1 is the absorbance of wavelength1; A2 is the absorbance of 
wavelength2; A3 is the absorbance of wavelength3; K is the factor in Dual-WL Factor.  
  
Sample Info 
Input the remark (explanatory description) of the sample, for example, the sample 
submitter, date of sample submitted, sample name, dilutability, standard sample or 
not and concentration.  
 
Exclude 
When it is checked, this point will not be included in the curve. Note: this option is 
only available in the Standard Table after the data measurement is finished.  
 
Standard Curve 
  
During the measurement, the acquisition data changes accordingly. During the 
acquisition, the data points measured will be displayed on the corresponding 
coordinate points (marked by green triangle points). The corresponding standard 
curve is drawn according to the curve order set after the measurement is finished. 
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 Tip: 

 When measuring the sample, the data points measured will be displayed on 
the corresponding coordinate points (marked by red rhombic points) during 
the acquisition as shown in the figure above. 

 
Parameter List 
  
Display the current curve coefficient and the related coefficient. 
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4.4.5 To Execute the Auto Zero of Quantitation 

Measurement 
 
In Auto Zero, the system samples at a certain sample rate and averages the points 
acquired during specified period. This average is taken as the aero value and will be 
subtracted from all the measurement values.  

After setting the sample parameters, click under the Acquisition menu and the 
instrument performs auto zero. The dialog box as shown in the figure on the next 
page will be displayed after the auto zero is finished.  

 

 

 Note: 

 Auto zero must be performed to adjust the output to zero before each 
quantitation measurement; otherwise, the measurement accuracy might be 
affected. 

 Other operations are unavailable during auto zero. 
 

 Tip: 

 If the software is closed or the instrument is disconnected during auto zero, 
the dialog box as shown in the figure below will be displayed at the next 
start-up of the software and connection of the instrument. 
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4.4.6 To Run Quantitation Measurement 
 
After auto zero is finished, click Run under the Acquisition menu, the instrument 
makes measurement according to the parameters set and the measured data is 
displayed in the table.  
  

When multiple samples are measured, the dialog box as shown in the figure below 
will be displayed to inform you to change the sample after the measurement of the 
current sample is finished.  

 

After the measurement is finished, the dialog box informing you that the 
measurement is finished will be displayed; click OK to finish the measurement. If 
you want to make repeated measurement of the current setting, click Run. At the 
same time, the current wavelength and absorbance are displayed in the status bar in 
the main interface. 

 Note: 

 If you do not change the sample and click OK directly, the instrument will 
continue to measure the previous sample and the measurement results will 
be affected. 

 Do not close the software or turn off the instrument during the measurement; 
otherwise, the measurement results will be lost and abnormal prompt 
message will be displayed at the next start-up of the software. 

 

 Tip: 

 This function is only available after sending the method. 
 You can click Stop or Abort to stop the measurement during the 

measurement. 
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4.4.7 To Stop Quantitation Measurement 
 
Click Stop or Abort under the Acquisition menu to stop the current measurement.  
 
  
The difference between Stop and Abort 
  
Stop 
 
The instrument stops the measurement and saves the measurement data. You can 
click Run to resume the measurement without performing the auto zero again. 
  
Abort 
 
The instrument stops the measurement without saving the measurement data. You 
can click Run to run the measurement again. 
 

 Note: 

 The Stop or Abort operation is only available after sending the method and 
starting the measurement. 

 
 

4.4.8 Data Processing of Quantitation 

Measurement 
 
When the quantitation measurement is finished, the data measured will be stored in 
the default storage directory of the system and you can view and analyze the 
measurement result directly. The concentration of the sample is calculated according 
to the standard curve and when different standard curves are used, the 
concentrations would differ. Click Method, select different curve orders in the 
Curve Order dropdown box and click Acquisition to view different curves. 
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First-order Curve 
 

 
Cubic Curve 
 
Click Save in the Data option under the File menu to save the current data in the 
default directory; or click Save As to save the current data in the specified directory.  
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Right-click in the standard curve area to perform a series of follow-up 
operations on the chromatogram via the pop-up dropdown list. For details, 
refer to Follow-up Operations of Chromatogram. 
 

 Tip: 

 Click Close in the Data option under the File menu to close the current data 
file. 

 Click the boundary between the table and the standard curve chromatogram, 
a dotted line as shown in the figure below appears, hold the mouse and drag 
the dotted line left or right to enlarge or reduce the standard curve area. 
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Chapter 5 Report and Log 
 

 Main topics: 

 Report  

 Log  
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5.1 Report 
 
The report generator is used to generate, edit, save and print the user-defined report. 
The report could contain pictures, texts and page header/footer. Besides, you can 
edit the four modules currently measured or opened at the same time. 
 

 Main topics: 

 To Create Template  

 To Edit the Report  

 Follow-up Operations of Editing  

 Print and Store  

 Operation Example  
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5.1.1 To Create Template 
 

After the measurement is finished, click to activate the report 
window and the software switches to the UltraUV-Report interface by default. You 
can create a new template via this interface or open a template already exists.  
  
  
Create a new template 
  
To create a new template, click New under the File menu and the Message dialog 
box will be displayed to ask you whether to save the current report template or not 
as shown in the figure below. Click Yes to save the current template in the specified 
directory; click No to apply the template newly created. 

 

 

 Tip: 

 Click Open in the Template option under the File menu to directly recall the 
template saved. 
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5.1.2 To Edit the Report 
 

After creating the template, click Edit to switch to the editing interface as shown in 
the figure below to make user-defined editing on the report. 

 
 
The editing interface mainly consists of the following parts. 

 Toolbar  

 Text Objects  

 Measurement Objects  

 View  
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5.1.2.1 Toolbar 
 

 
 

New Page 
  
Create a new page and the page number is displayed at the upper left corner of the 
page.  
  
Delete Page 
  
Delete the page currently opened. 
  
Pre Page 
  
View the previous page of the current page. 
  
Next Page 
  
View the next page of the current page.  
  
Page Header 
  
Click Page Header and input the desired page header in the pop-up Page Header 
dialog box as shown in the figure below.  

 
 
Click Font Setting in the figure above to set the font in the pop-up Font dialog box 
and click OK. 
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After finishing the setting, click at the upper right corner of the Page Header 

dialog box.  
  
Page Footer 
  
Refer to Page Header. 
 

 

5.1.2.2 Text Objects 
 

You can insert the following objects into the report. 
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Line/Rect/Circle/Round Rect 
Insert the corresponding shape into the report.  
 
Text 
Click Text and edit in the pop-up textbox. Right-click the textbox, select Properties 
in the pop-up dropdown list, click Font in the pop-up Properties dialog box to set 

the font and then click  at the upper right corner of the properties dialog box. 

  

 
Picture 
Click Picture, right-click the pop-up picture object, select Properties in the pop-up 
dropdown list, click Image in the pop-up Properties dialog box to select the 
desired picture and select the properties of the picture (Original size or Fit Control) 

and then click . 
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5.1.2.3 Measurement Objects 
 

UltraUV provides four kinds of measurement objects (spectrum measurement 
objects, kinetic measurement objects, photometric measurement objects and 
quantitation measurement objects). You can edit the four kinds of measurement 
objects at the same time and the four kinds of measurement objects are marked with 
white, blue, pink and green respectively for easy distinguish. 

 
 
Select the desired object to be saved or printed. Click the corresponding button to 
display the object on the page as shown in the figure below. 
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 Tip: 

 When Method is selected, right-click on the object and select Properties in 
the pop-up dropdown list to set the font of the method in the pop-up 
Properties dialog box. 

 
For the related operations of the object, refer to "Follow-up Operations of 
Editing". 
 

 

5.1.2.4 View 
 
In the View menu, you can set the page view and zoom scale. 
 
Page View 

Click View and make settings in the Page View option.  
  

Page Type 
Click the Page Type textbox and select the desired type from the dropdown list.  

 

 
Page Margins 
Click Page Margins and make settings in the pop-up Margins dialog box. Click OK 
to apply the current settings; click Cancel to give up the current settings.  
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Report View 

  

Click the Zoom textbox under the View menu and select the desired zoom scale 
from the pop-up dropdown list.  

 
 
 

5.1.3 Follow-up Operations of Editing 
 

You can perform the following operations after selecting the object to be edited.  
  

Move the object 
The objects selected are all displayed at the same position at the upper left corner of 
the page and you need to move them to the proper positions manually. Click and 
hold on the object to move it.   
  

Delete the object 
Click on the object and then press Delete on the keyboard to delete the object; or 
right-click on the object and then select Delete from the pop-up dropdown box.  
 

 

 



Chapter 5 Report and Log RIGOL 

UltraUV User’s Guide 5-11 

Copy/Cut/Paste 
Right-click on the object and select Copy or Cut from the pop-up dropdown box, 
then right-click on the blank of the page and click Paste.  
  

Zoom in or out the object 
Click on the desired object. At this point, size control points appear on the four 
corners and the middle point of each edge. Place the mouse on the control point, 
click and hold, then drag the mouse to zoom in or out the object.  
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5.1.4 Print and Store 
 

You can print or store the report for future use after editing the report.  
 
Print Preview 
  
Click Print Preview under the File menu to view the report to be printed and stored 
in the pop-up Print preview dialog box. You can set the page according to the size 
of each object and for the operations of the object, refer to "Follow-up Operations 
of Editing". 

 

 
Print 
Click Print under the File menu to print the report.  
  
Save/Save As 
Click Save under the File menu to save the report in the default directory; click 
Save As to save the report in the specified directory.  
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5.1.5 Operation Example 
 
As the report editing methods of the four modules are similar, spectrum 
measurement is taken as an example to illustrate how to print the report. 
  
 Operation procedures: 
  
  
Step1: 
 

Click to activate the report window after the spectrum 

measurement or the data processing of the spectrum measurement is finished. The 
software switches to the UltraUV-Report interface by default. You can create a 
new template or open a template already exists via this interface. For details, refer to 
To Create Template. 
  
  
Step2: 
  
Click Edit after creating the template to switch to the report editing interface to 
make user-defined editing on the report. Select the object (such as the method, 
chromatogram and peak pick) to be printed as shown in the figure below. For the 
report editing method, refer to To Edit the Report. 
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Step3: 
 
You can print and save the report after the editing is finished. For details, refer to 
Print and Store. 
  

 Tip: 

 The chromatogram printed contains all the chromatograms currently opened. 
The method, peak pick table and peak area table are all the chromatogram 
files in the active mode. 
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5.2 Log 
 
This software provides special log record function to facilitate your record of the 
related information during the operation. Besides, the system records and save the 
login information (include the user name, specific time and date of each login) 
everyday automatically. The default directory of the automatic storage is the UVLog 
folder under the directory of the installation file. 
 
  

Click and the instrument switches to the UltraUV-Log interface 
automatically as shown in the figure below.  

 
 
LogRegister 
  
Click LogRegister at the left and edit in the pop-up dialog box.  
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LogType 
 
Click the LogType textbox and select the desired log type (INFO, WARNING and 
ERROR) from the pop-up dropdown list. 
  
Module 
  
Input the module to be recorded in the textbox.  
  
Message 
  
Input the related information to be recorded in the textbox.  
  
OK 
  
Click OK, the log edited will be displayed in the Log Register Table and the user 
name and current time will be generated in the corresponding tables automatically.  
  
Cancel 
  
Click Cancel to give the current record.  
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 ClearDisplay 
  
Click ClearDisplay at the left to clear all the records in the Log Register Table.  
 
 
 

Tip: 

 Click Open under the File menu to view the log saved; click Save As to save 
the log in the specified directory. 
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Chapter 6 Troubleshooting 
 

The commonly encountered problems and their solutions are listed below for your 

analysis and process the common problems. If the problem remains after taking the 

corresponding solution or the problem is not contained in the table below, please 

contact RIGOL. 

  

The commonly encountered problems and their solutions are as follows. 

 

Faults Possible Reason Solution 

Instrument 
can not be 
connected. 

Whether the instrument 
is powered on correctly 

Check whether the power cord is 
properly connected and whether the 
instrument is started 

The communication 
port is occupied 

Please use a free port or free the port 

The instrument is 
damaged 

Contact RIGOL 

Connection is wrong Contact RIGOL 

Self-test fails 

The lamp is aged and 
can not be turned on 

Replace the lamp 

The photomultiplier is 
aged 

Replace the photomultiplier 

There is sample in the 
sample compartment 
and the light can not 
pass through  

Take out the sample in the sample 
compartment 

The optical parts are 
aged 

Contact RIGOL 

The circuit board is 
aged 

Contact RIGOL 

The 
absorbance 
can not return 
to zero 

The service life of the 
lamp expires 

Replace the lamp 

The photomultiplier is 
aged 

Replace the photomultiplier 
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Preamplifier circuit 
failure  

Contact RIGOL 

The deuterium 
lamp does not 
light up  

The service life of the 
deuterium lamp expires 

Replace the deuterium lamp 

The environment 
temperature is too low 

Make sure the environment 
temperature is above 15℃ 

Deuterium lamp power 
circuit failure 

Contact RIGOL 

The tungsten 
lamp does not 
light up 

The tungsten lamp 
filament is blown 

Replace the tungsten lamp 

Circuit failure Contact RIGOL 

The 
absorbance 
value is 
negative 

Blank memory is not 
performed and the 
absorbance of the 
sample is lower than 
that of the blank 
reference solvent 

Perform blank zero 

Circuit failure Contact RIGOL 
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